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Preface
About this manual
This Profile XP User Manual describes the standard Profile XP applications used to manage
the day-to-day operation of your Profile XP Media Platform This manual assumes you have
already installed your Profile XP system using the Installation Guide and Profile XP System
Guide shipped with your unit.

Using the Profile XP Documentation Set
This manual is part of a full set of support documentation for the Profile XP Media Platform.
The following diagram illustrates how to use the Profile XP documentation depending on the
task you are performing.
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Path for the Installer

Release Notes

Installation Guide

Contains the latest
information about Profile XP
hardware and software
shipped with your system.

Contains the product description
Contains essential steps for
and step-by-step instructions for
installing your Profile XP
modifying system settings.
system with local storage,
using factory default settings.

System Guide

Use alternate procedures
for shared storage option.
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These manuals include:
- PFC500 Instruction Manual
- PFR500 Instruction Manual
- PFR600 Instruction Manual
- PFR700 Instruction Manual
- Profile XP Service Manual
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Other Manuals

Open SAN
Instruction Manual and Release Notes
Contains instructions for installing storage
that is shared by multiple Profile XP systems.
Installers consult
the User Manuals
as needed.
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Path for the Operator

Release Notes

User Manuals

Contains the latest
information about Profile XP
hardware and software
shipped with your system.

Contains complete instructions for using
Profile applications. These manuals include:
- Profile XP User Manual
- Other user manuals you received with
optional Profile applications.
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Manual descriptions
• Installation Guide (for your Profile XP Model) This guide provides step-by-step instructions
for installing the Profile XP Media Platform using factory default settings for all record/
play channels. Factory default settings are indicated within the guide. After installing the
Profile XP system using this installation guide, you can refer to this Profile XP System
Guide to customize system settings for your installation.
• Profile XP User Guide Contains complete instructions for using Profile applications to
operate the Profile XP Media Platform.
• Profile XP System Guide This guide provides all the information you need to go beyond
factory default settings and customize your system’s configuration to meet your
site-specific needs. This guide also provides an overview of your Profile XP system, and
provides all the specifications you need to integrate the Profile XP Media Platform into
your operation.
• Profile XP Service Manual Contains information for servicing the Profile XP Media
Platform, and includes procedures for the following tasks:
- Problem analysis using symptom, problem, solution tables.
- Running diagnostics locally and remotely
- Set up and operation of NetCentral remote monitoring software.
•

•

•

•

•

•
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- Replacing field replaceable units.
Profile XP Release Notes Contains the latest information about the Profile XP hardware and
the software release shipped on your system. This information includes software
specifications and requirements, feature changes from the previous releases, helpful system
administrative information, and any known problems.
PFC500/E Instruction Manual Contains information for servicing the Profile XP Fibre
Channel RAID Storage Chassis (PFC500/E) including step-by-step procedures for
replacing field replaceable units.
PFR500/E Instruction Manual Contains information for servicing the Profile XP Fibre
Channel RAID Storage Chassis (PFR500/E) including step-by-step procedures for
replacing field replaceable units.
PFR600/E Instruction Manual Contains information for servicing the Profile XP Fibre
Channel RAID Storage Chassis (PFR600/E) including step-by-step procedures for
replacing field replaceable units.
PFR700/E Instruction Manual Contains information for servicing the Profile XP Fibre
Channel RAID Storage Chassis (PFR700/E) including step-by-step procedures for
replacing field replaceable units.
Open SAN Instruction Manual Describes how to install, configure, and maintain the
hardware and software components that comprise an Open SAN, Grass Valley’s shared
storage solution.
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How this manual is organized

How this manual is organized
The Profile XP® User Manual supports Profile System Software 5.0 for the Profile XP Media
Platform. The Profile XP Media Platform uses digital technology to store and produce
broadcast-quality MPEG video and broadcast quality audio. This manual documents the
standard software applications that are included on the Profile XP Media Platform:
Chapter 1 - Introducing the Profile XP Applications
Introduces the standard and optional Profile XP applications. Each application is best suited
for a specific task. This chapter helps you decide which application to use.
Chapter 2 - Using VdrPanel
Describes how to use the VdrPanel application to record and play back MPEG video and audio
clips. It also tells you how to configure a channel for external control through an RS-422 port.
Chapter 3 - Using Media Manager
Media Manager manages clips and masters on disk. With Fibre Channel, you can use Media
Manager to copy or move media between Profile systems. The Transcode Utility included in
Media Manager converts media between different compression rates.
Glossary
This appendix explain terms used throughout this manual, and in the industry.
NOTE: This manual assumes that you are familiar with basic Microsoft
Windows operation.
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Terminology and conventions
Button (graphical) Buttons shown in bold (OK, for example) that you click with the mouse
pointer.
Button (mouse)

The two or three buttons on the top of the mouse.

Choosing

Choosing menu items, File | Exit, for example. (File | Exit means choose
the Exit menu item under the File menu.)

Commands

Commands (a:\setup, for example) are shown in bold.

Clicking

Pressing and releasing the mouse button without moving the pointer.

Ctrl

key

Double-clicking

Pressing and releasing the left mouse button twice without moving the
pointer.

Dragging

Pressing and holding the mouse button while moving the pointer.

Moving

Changing the location of the pointer on the screen by moving the
mouse.

Pointer

An arrow or other graphic on the screen indicating the current cursor
position for selecting or clicking.

Pointing

Positioning the pointer on an object on the display by moving the
mouse.

Right-click

Pressing and holding the right mouse button.

Shift

8

Hold Ctrl down while pressing other keys in a sequence.

key
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Hold Shift down while pressing other keys in a sequence.
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Introducing the Profile XP Applications
Profile XP Media Platforms store broadcast-quality video and audio on computer disk drives
rather than on video tape, allowing almost instant access to any timecode location of your
video and audio material.
A Profile XP media platform is more than just a one-for-one replacement of a VTR: it can have
up to eight video channels in various record and playback combinations. Clips are available
on all channels at once, so you can play a clip on more than one channel at the same time,
without making a copy of it. Since each channel is independent of the others, each playback
can start at a different time and at a different place in the clip.
You can even start playing a clip while it’s still being recorded. Just start capturing the clip on
one channel, wait about five seconds, and then play the clip back on another channel. This kind
of control makes the Profile XP system an ideal solution if you want to go to air with a clip
before you have finished recording it.
What sets a Profile XP Media Platform apart from a VTR is its ability to be controlled by
software applications. Grass Valley provides a set of standard and optional software
applications, described later in this section, that provide basic tools for managing your Profile
XP Media Platform.
While you can use any of these applications directly on your Profile XP system, most of them
will also run on a remote PC. This allows you to control your media platform over an Ethernet
connection from another room or another building. The full-featured NetCentral application,
described in the NetCentral User Guide, even lets you monitor the status of your Profile XP
from a remote location.
If you don’t find all the capabilities you want in any of the Profile applications, you can turn
to one of Grass Valley’s partners to find exactly the application you need. By using the Profile
software development tools, described in the next section, these partners have developed tools
such as automation systems, simple or sophisticated editors and live event controllers that
exploit all unique features of your Profile XP Media Platform. These applications may run
locally, over the Ethernet, or control your system through one of its RS-422 ports.
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Introducing the Profile XP Applications

Profile software development
The Profile Software Development Kit (SDK) provides an application programming interface
(API) for libraries of Profile functions. We recommend that you call these functions via
Microsoft Visual C++ 6.0; however, it is possible to use other languages that permit calls to C
declared functions (contact your Grass Valley representative for more information). Software
developers can use the API to control the Profile system from third-party hardware devices,
for example. The API consists of seven libraries:
• The TekCfg library provides an interface to the Profile configuration.
• The TekPdr library furnishes calls that inventory and manage movies in Common Movie
Format (CMF), an internal file format standard for video, audio, and timecode.
• The TekRem library makes it possible for a remote Windows NT system to control a Profile
disk recorder over an Ethernet LAN.
• The TekVdr library provides an interface for playing and recording video and audio clips.
• The TekVfs library supports low-level access to individual media files in the media file
system.
• The TekXfr library supports media streaming of Fibre Channel connections.
Eight RS-422 serial ports come standard on a disk recorder. A disk recorder can issue serial
commands or receive them from an external device via RS-422 communication lines. The
Profile Protocol associates each API call with a specific number that can be sent over an
RS-422 line. The ProLink application monitors Profile Protocol calls over an RS-422 link,
allowing you to use compatible hardware devices, such as the PRC100 Control Panel, to issue
commands to a Profile unit.
Windows applications are also available to control the Profile system. Your media platform
comes with several standard and optional applications. See “Starting and closing Profile
applications” on page 12 for more information.
NOTE: VDCP controls and Odetics RS-422 control protocols are also supported,
although there is not a one-to-one correspondence between these protocols and
the Profile API. VDCP and Odetics controls do not allow you full access to the
functionality of the Profile system.

10

Profile XP User Guide

23 July 2004

Starting your Profile XP system

Starting your Profile XP system
Once the unit is properly installed and configured, you are ready to log in for day-to-day
operations. For instructions on how to install and power-on a Profile XP system, see the
Installation Guide and Profile XP System Guide that came with the unit, or if the Profile XP
media platform is part of an Open SAN, refer to the Open SAN Instruction Manual for
power-on instructions.
To log in automatically:
Power up the Profile XP unit, and the start up routine begins. During normal start up, you
are logged in automatically. You can hold down the Shift key during start up to interrupt
the automatic log in process.
NOTE: If you stop the automatic log in, or if it fails, the Windows NT log in
dialog box appears. When logging in, remember that this dialog box is
case-sensitive.
To manually log in:
1. At the Windows NT 4.0 log in window, enter the username: profile (However, you must log
in as administrator when installing software, performing Windows NT administration,
starting a service, or setting an Ethernet IP address.)
2. Use the Tab key to advance to the password field.
3. The password appears as asterisks (*) for password security. For the password, enter: profile
4. Use the Tab key to advance to the From field.
5. If your domain name or local computer name is not displayed in the box, click in the box
to access a list of choices. Select your domain or local computer name from the list.
6. Click OK or press Enter.
NOTE: If a log in error message appears, and all the information is correct, try
deleting the password and clicking OK.
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Introducing the Profile XP Applications

Starting and closing Profile applications
After logging into your Profile system, you see shortcut icons for the Profile applications on
the Windows NT 4.0 desktop.

12
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Starting an application

Starting an application
To start a Profile XP application — VdrPanel in these examples — using Windows NT 4.0:
• Double-click the shortcut icon on the Windows NT desktop.
Or:
• Choose Start | VdrPanel.
Or:
• Choose Start | Programs | Profile Applications | VdrPanel.

Viewing Help
To view the Help for an application:
• Choose Help | Help Topics.
Or:
• Click the Help button in a dialog box or a toolbar, if available.
To view version information (for VdrPanel in this example):
• Choose Help | About VdrPanel.

Closing an application
To close Profile applications:
• Choose File | Quit, File | Exit or click the Close button.
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Introducing the Profile XP Applications

Standard applications
The following software applications are installed at the factory on every Profile XP Media
Platform. The short descriptions should help you understand when to use each application.

VdrPanel
VdrPanel lets you to capture and trim video and
audio clips and then play them back. It also lets
you configure your channels for control by
external devices through the RS-422 ports. For
more information, refer to Chapter 2, “Using
VdrPanel.”

Media Manager
The Media Manager allows you to manage clips and
masters on your local Profile XP Media Platform. You
may also use Media Manager to launch the Transcode
Utility. Refer to Chapter 3, “Using Media Manager.”

Transcode Utility
The Transcode Utility, which is started from Media Manager,
creates new clips in the same compression format but
different video quality. It can also convert clips from one
compression format to another (DVCPRO 25 to
DVCPRO 50, for example) on Profile systems that support
more than one compression format, such as the PVS1100.
Refer also to Chapter 3, “Using Media Manager.”

14
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Optional applications
The following optional software applications—Tool Box Editor, List Manager and
TimeDelay—address specific needs that aren’t covered by the standard Profile software
applications. Tool Box Editor and List Manger are included in the Profile Tool Box package,
and TimeDelay is available as a separate application.

Tool Box Editor
The optional Tool Box Editor lets you create new
media by logging and capturing video and audio
clips while also providing an inexpensive,
cuts-only editing system. Refer to the Tool Box
User Manual.

List Manager
The optional List Manager allows you to set up
simple station automation. You can record
incoming video at predetermined times, send
incoming video directly to an output, or combine
all of these functions to increase the automation
level of you operations. Refer to Tool Box User
Manual

TimeDelay
TimeDelay allows you to delay incoming video by an
amount of time you specify. For more information, see
TimeDelay User Manual.
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2

Using VdrPanel
Storing media on a Profile XP Media Platform rather than on tape opens the door to almost
instant access to digital video and audio material. Media is available to all of the Profile XP
Media Platform’s channels at once, so you can play a video and audio clip on more than one
channel at the same time. Since each of the channels is independent, playback can start at a
different time and place in a clip. One of the best features of the Profile XP system is that you
can start playing material while it’s still being recorded.
The basic element of digitally stored video and audio is the clip. A clip is a reference to video,
audio, and timecode material recorded in media files on the Profile XP media disks. A clip has
a beginning and an end, and, when first recorded, the beginning and end correspond to the first
and last frames stored in the media file. When you delete a clip, the media file that the clip
refers to remains on disk if at least one other clip refers to it—only the reference to the media
file is deleted, not the media itself.
A clip may refer to the entire media file or just part of it. You can mark in and out points in a
clip. These marks change the effective beginning and end points of a clip, while not removing
the associated material from the media file. On the other hand, you can trim media to remove
material from either end of a clip, which also removes the information from the media file.
Trimmed material is permanently removed from disk and is no longer available for use.
The default tool for creating and playing clips on the Profile XP system is VdrPanel. VdrPanel
provides you with a VTR-like interface—complete with transport controls—to directly
manage media operations. Once created with VdrPanel, clips are available for use with Profile
XP applications, such as Tool Box Editor or the List Manager.
VdrPanel allows you to configure any or all of your channels for operation through a
controller connected to an RS-422 serial port. These controllers may comply with VDCP,
Odetics, or BVW protocols.
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Using VdrPanel

Before using VdrPanel to capture clips, you must complete a few steps:
1. You must select a channel for use with each panel. At the same time, you must decide
whether you want to use the Windows NT interface (called Panel Control) to capture and
play clips, or if you want to use an external device to control your Profile XP system. If you
select an external controller, you must select a port for use with the controller. See
“Configuring a panel” on page 19.
2. You can select timecode panel display, which timecode generators to use, and select
drop-frame timecode. See “Selecting how to display timecode on a panel” on page 22.
For information on how to start and close VdrPanel, see “Starting and closing Profile
applications” on page 12.
The VdrPanel window is shown in here. By default, the VdrPanel window appears
automatically at power-up, unless you log in manually. You display all available panels in the
VdrPanel window—up to eight, depending on your system. Each panel is dedicated to one
channel.

18
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Configuring a panel

Configuring a panel
Before you can use a panel, you must first configure it. You must select a protocol and a
control port for your panel, or select Panel Control to use the VdrPanel to record and play back
clips without using an external controller. You must also select the channel to use with the
panel. A channel assigns resources such as video audio, and timecode inputs and outputs, as
well as encoders and decoders to the panel. Channels are created or modified by Configuration
Manager. See the Profile XP System Guide for more information about creating and modifying
channels in Configuration Manager.

Selecting a channel, protocol, and port
1. Click a panel to make it active.
2. Choose Controller | Configure to open the Channel Configuration dialog box.

3. Select the Protocol for the channel, such as VDCP Control. Select Panel Control if you want
to use only the Windows NT panel to record and play back clips.

23 July 2004
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Using VdrPanel

4. If you selected a protocol other than Panel Control, select the communications port that is
connected to the desired external controller. Ports P1 through P8 are available on the
RS-422 Connector Panel. COM1 is available on the unit’s back panel (an RS-232 DB-9
connector).
5. Select a channel for use with the panel from the Channel drop-down list box. You can scroll
through the Channel Information list to see what resources are specified by each channel.
6. Click OK to have your channel, protocol, and port selections take effect.
If you use Configuration Manager to change a channel’s name or resources, you must reselect
the modified channel in VdrPanel for the change to take effect. You may also choose
Controller | Reacquire Channel to update the channel for the current panel.

Selecting clip length (BVW Only)
If you have chosen a BVW controller, you can specify clip length by setting mark in and mark
out points:
NOTE: The Set Clip Marks (clip length) dialog box shown here will not appear
unless the panel controller is a BVW controller. This is not the same as setting
clip length while in Loop mode.
1. Click a panel to make it active.
2. Choose Controller | Clip Length. The Set Clip Marks dialog box appears.

3. Enter the mark-in and mark-out points by specifying the hour, minute, second, and frame
settings. This applies to future clips only, unless you perform step 4.
4. Click Apply to Loaded Clip(s) if you want the mark-in and mark-out points to apply to
existing clips as well as future clips.
5. Click OK.

20
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Setting VDCP modes
If you use VDCP control, you can set the VDCP modes for the panel. These include VDCP
switcher mode and VDCP stop mode.
NOTE: VDCP menu commands are available only when the panel controller is
set to VDCP control.

Setting VDCP switcher mode
Normally, when a clip is cued, a freeze or confidence frame appears on the monitor instead of
a regular video input feed. In switcher mode, you do not see a confidence frame: you see video
input from the feed until you play the clip. When the clip is done playing, you immediately
see the regular video input again.
To set a panel to switcher mode:
1. Click the panel to activate it. The panel controller must be VDCP control. For information
on how to set the controller to VDCP control, see “Configuring a panel” on page 19.
2. Choose Options | VDCP Switcher Mode. A check mark appears next to VDCP Switcher
Mode in the Options menu to show that it is activated.
3. To return the panel to normal mode, choose Options | VDCP Switcher Mode again.

Configuring VDCP stop mode
You can select which frame to display when playback of the current clip finishes and the next
clip in the group must be cued but not played immediately following the current clip. VdrPanel
allows you to configure the stop mode on each panel under VDCP control.
To configure the VDCP stop mode for a panel:
1. Click the panel to activate it. The panel controller must be VDCP control. For information
on how to set the controller to VDCP control, see “Configuring a panel” on page 19.
2. Choose one of the VDCP stop mode options:
• Choose Options | VDCP Stop Mode | Last Frame to freeze on the last frame of the current
clip. The next clip is cued and ready to play. The preroll on the VDCP controller must
be set to at least two frames for this operation. If the preroll is less than two frames, the
Non-End Mode will take effect.
• Choose Options | VDCP Stop Mode | End Mode to freeze on the first frame of the next clip.
The preroll on the VDCP controller must be set to at least two frames for this operation.
If the preroll is less than two frames, the Non-End Mode will take effect.
• Choose Options | VDCP Stop Mode | Non-End Mode to play several frames of the next clip
in the group, then recue the clip and freeze on its first frame.
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Using VdrPanel

Selecting how to display timecode on a panel
The Timecode Setup dialog box enables you to set the timecode display and the timecode
source on a channel to the values required for your application.
1. Click in a panel to select it.
2. Choose Options | Select Timecode to open the Timecode Setup dialog box. The Timecode
Setup dialog box is divided into two groups: Display on Panel and Timecode Generator
Settings.

3. Select the timecode to be displayed on the panel from the Display on Panel group:
- LTC Input is a separate signal input via the genlock card.
- VITC Input is the timecode from the VITC input signal.
- Compute from Field Number calculates the timecode directly from the field number of
the recorded video. New clips start at 00:00:00:00.
- TC Rec # displays the recorded timecode.
- Generator displays the timecode from the generator for the channel.
4. Set up the timecode generator used by the panel with the Timecode Generator Settings
group:
- Free Run causes the timecode generator to continue to advance regardless of the
current play or record mode of the panel.
- Freeze locks the timecode at the current value. The value does not advance with time
nor with changes in the play or record mode of the panel.
- Lock to Field Number causes the generator to output a timecode locked to the current
clip’s timecode. When the panel is in stop, the value freezes. When the panel is in play
or record, the timecode advances normally. During rewind or reverse shuttle, the
timecode runs backward.
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Setting drop-frame timecode
- Regenerate pertains to BVW controllers only. When the timecode position is changed
to a new portion of the clip, and a record operation includes recorded timecode tracks
(which happens with assemble edits from BVE and other controllers), the timecode
generator is initialized to match the timecode read from the timecode track (VITC or
LTC) before the record occurs.
- The Reset To button resets the timecode to the value entered in the box. The generator
can be set to this value when Free Run, Freeze, or Lock to Field Number is selected.
5. Click Close.

Setting drop-frame timecode
In NTSC and 525/60, you don't actually get 30 frames per second; the real number is about
29.97 fps. Timecode usually assumes 30 fps. To account for the discrepancy, drop-frame
timecode skips or drops two timecode values at the beginning of every minute except every
tenth minute. This allows timecode to exactly match a real-time clock on 525/60 systems. This
correction is not needed on PAL or 625/50 systems because the frame rate is exactly 50 fps.
To set drop-frame timecode:
• Choose Options | Drop-Frame or Options | Non-Drop-Frame.
NOTE: This setting applies to all open panels.
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Panel basics
In the VdrPanel application, you can display up to eight Panel dialog boxes at a time, one for
each video channel. Each Panel dialog box has independent controls. A close-up view of a
Panel dialog box is shown here. A description of each Panel function follows.
NOTE: If the panels are stacked, choose Window | Tile Panels.
The VdrPanel interface follows the same conventions as other Windows NT applications: the
control menu box, title bar, menu bar, minimize and maximize buttons, mouse and keyboard
all perform as expected. Refer to specific operating information about these items in the
Windows NT manuals.

4. Timecode

3. Play/Record Mode
Normal/Loop

2. Size

1. Type
25. Group Name

5. Stop

24. Clip Name

6. Rewind

23. Shuttle Rate

7. Record

22. Shuttle Bar

8. Play

21. Go to Clip
Beginning

9. Fast
Forward

20. Back One
Field
19. Forward
One Field

10. PB/EE
11. Clip
Position Bar
12. Remove In
Mark
13. Set In
Mark

14. Trim to
In Mark

18. Go to
Clip End
15. Trim from 16. Set Out
Out Mark
Mark

17. Remove
Out Mark

1. The Type box shows the type of pictures: I for Intra-coded (I-frame), B for
Bidirectional-predictive coded, and P for Predictive-coded.
2. The Size box shows the number of bytes stored for the current frame. The more detailed the
picture, the higher the number of bytes. The compression rate is set for the channel. Use
Configuration Manager to change this setting.
3. The Play/Record mode allows you to choose how your clips will be recorded or played.
Select Normal to play the selected clip or clip list to the end, freezing on the last field of
the clip or of the last clip in the list. Select Loop to play the selected clip or clip list
continuously, looping back to the beginning of the clip when the clip ends, or in the case
of a clip list, looping back to the first clip in the list when the last clip ends. If you create
a clip while in Loop mode, you are asked to enter a clip length in the form 00:00:00:00
(Hours:Minutes:Seconds:Frames). The Record operation will automatically stop at the
specified timecode, thus protecting disk storage space.
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4. The Timecode box is the current timecode of the selected clip. To configure your timecode
display, refer to “Selecting how to display timecode on a panel” on page 22. For example,
when you use slow motion replays from several camera angles, the timecode can free run
or freeze. Clicking on the Timecode box brings up the Go To Timecode dialog box.
Entering a new timecode value and clicking OK moves a clip to a specific timecode
location. If there is no recorded timecode, VdrPanel displays a timecode calculated from
the current position (00:00:00:00 or above).

5. The Stop button halts the current Play, shuttle, or Record function.
6. The Rewind button shuttles the clip backwards to the beginning (the first available field or
in mark) of the selected clip. Use Go To Clip Beginning or enter a timecode value in the
Timecode box to move directly to the beginning without shuttling. This button may not be
available on panels configured as Recorder only.
7. The Record button starts storing the incoming video as MPEG streams and audio under the
selected clip name. If no clip is selected, a default clip name (pound sign [#] followed by a
number) is assigned. (See “Defining a new clip” on page 31.) The record process continues
until the disk decoder runs out of storage space or you click another command button, such
as Stop. Recording does not start unless there is a video signal assigned to the selected panel
and there is disk storage available. This button is not available on Play only channels.
8. The Play button runs the selected clip at normal speed. If there are multiple clips in the clip
list, Play starts with the first selected clip and proceeds through the list. Normal and Loop
modes determine how the clip or clip list is played. This button is not available on panels
configured as Recorder only.
9. The Fast Forward button shuttles the clip forward to the end. Use Go to Clip End or enter a
value in the Timecode box to move directly to the end of the clip without shuttling. This
button may not be available on panels configured as Recorder only.
10. The PB/EE (Playback/E to E) button determines the action during Stop or Record. If you
select Playback, the recorded image is displayed as a still during Stop, and audio is
silenced. If E to E is selected, the input signal is routed through to the display during Stop
or Record.
11. The Clip Position Bar displays the relative position of the current frame within the current
clip. For example, if the Clip Position Bar is to the far left, the frame is at the beginning
of the clip; if it is at the far right, the frame is at the end. Click on the bar to activate it or
press j or ↓.
12. The Remove In Mark button removes the in mark and restores the clip to its first available
field.
13. The Set In Mark button sets the in mark for the current clip at the current timecode (you

23 July 2004

Profile XP User Guide

25

Chapter 2

Using VdrPanel

can also press i). When the clip is played, it starts at the in mark instead of the clip
beginning; however, the portion before the in mark is not lost. Use Remove In Mark to
remove the in mark. The in mark only affects this instance of the clip. If the clip repeats
in the clip list or is used by another panel, this in mark is not automatically present.
14. The Trim to In Mark button removes the portion of the current clip preceding the in mark
(you can also press c). This action affects all copies of this clip on all panels. The
trimmed material is not retrievable. A warning message and verification prompt are
displayed before the material is trimmed.
15. The Trim from Out Mark button removes the portion of the current clip following the out
mark (you can also press u). This action affects all copies of this clip on all panels. The
trimmed material is not retrievable. A warning message and verification prompt are
displayed before the material is trimmed.
16. The Set Out Mark button sets an out mark for the current clip at the current timecode (you
can also press o [not zero]). When the clip is played, it ends at the out mark; however,
the portion after the out mark is not lost. Use Remove Out Mark to remove out mark. An
out mark only affects this instance of the clip. If the clip repeats in the clip list or is used
by another panel, the out mark is not automatically present.
17. The Remove Out Mark button removes the out mark and restores the clip to its last
available field.
18. The Go to Clip End button jumps to the end of the current clip. You can also press e.
19. The Forward One Field button moves the current clip position forward one field. You can
also press the → key. In addition, Shift + → advances the clip position 10 fields or 5
frames, and Ctrl + → advances the clip position 100 fields or 50 frames.
20. The Back One Field button moves the current clip position backward one field. You can
also press the ← key. In addition, Shift + ← reverses the clip position 10 fields or 5
frames, and Ctrl + ← reverses the clip position 100 fields or 50 frames.
21. The Go to Clip Beginning button jumps to the beginning of the current clip. You can also
press t.
22. The Shuttle Bar sets the shuttle rate. Use the mouse to drag the pointer to the desired
shuttle rate (displayed in the Shuttle Rate box). When you click on the shuttle bar, the
disk recorder enters shuttle mode. You can also press h.
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23. The Shuttle Rate box displays the current shuttle rate. This number ranges from –16.00
to +16.00, with the positive numbers indicating forward motion, negative numbers
reverse, and 0.00 still. This number can be set by clicking on the Shuttle Rate box to open
the Shuttle Rate dialog box, entering a shuttle rate and clicking OK. You can also drag
the Shuttle Bar to a desired position. If the shuttle rate is set faster than the maximum rate
for the controller, the maximum rate is displayed.

24. The Clip Name box lists the names of the clips in the current clip list.
25. The Group Name box lists the name of the current clip list.
The functions on the Panel dialog box can be accessed directly by clicking on the appropriate
button with the mouse or by using the shortcut keys shown in Table 1. For example, pressing
Shift + R starts recording in the active panel.
Table 1. VdrPanel shortcut keys
Shortcut Key
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Function

Shortcut Key

Function

Shift + R

Record

Ctrl + ⇒ (right arrow)

Forward 100 Fields

w

Rewind

Ctrl + ⇐ (left arrow)

Back 100 Fields

s

Stop

j or ⇓ (down arrow)

Jog controls

p or ⇑ (up arrow)

Play

e

Go to Clip End

f

Fast Forward

h

Shuttle controls

spacebar

Stop

t

Go to Clip Beginning

Ctrl + A thru H

Activate panel A thru H

i

Set Mark In

⇒ (right arrow)

Forward 1 Field

o

Set Mark Out (not zero)

⇐ (left arrow)

Back 1 Field

Shift + C

Trim to Mark In

Shift + ⇒ (right arrow)

Forward 10 Fields

Shift + U

Trim from Mark Out

Shift + ⇐ (left arrow)

Back 10 Fields

F1

Start Help
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Opening a panel
If none of the panels are visible, here are the steps to open a panel:
1. Choose Window | Open Panel. The Open a Panel dialog box appears.

2. Select the panel you want to display, Panel A through H. Only panels that are not currently
open appear in the dialog box. You can also press Ctrl + A through Ctrl + H to activate panels
A through H.
3. Click OK.

Making a panel active
To make a panel active, such as Panel A, do either of the following:
• Click anywhere inside Panel A, if open.
Or:
• Choose Window | 1 Panel A: Panel Control.

Arranging panels and icons
If a panel is obscured by another panel, you can arrange the panels so that they are all
completely visible. To arrange the panels in this way:
• Choose Window | Tile Panels.
If you have minimized the panels, you can arrange the icons with:
• Choose Window | Arrange Icons.
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Viewing record capacity
The Record Capacity dialog box shows the amount of recording time remaining on the current
media disk volume according to the current compression presets. To view the recording
capacity:
1. Click a panel to make it active.
2. Choose Window | Record Capacity. A message box appears. In this instance, the message
box shows the internal disks labeled INT:. The recording time remaining is represented in
Hours:Minutes:Seconds. For more information on compression settings, see the Profile XP
System Guide.

3. Click Close.
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Viewing an audio monitor for a panel
The Audio Monitor allows you to monitor the level of an audio signal for a panel. To view a
panel’s audio monitor:
1. Click a panel to make it active.
2. Choose Window | Audio Monitor. The Audio dialog box appears. There are only two
channels in this example, but up to 32 channels are possible if the necessary boards are
installed.

Close Button
Play or Record
Level Indicators
Peak Indicators

Channel Indicators

Play or Record Level Controls

3. To turn peak hold on or off, choose PeakHold | On or PeakHold | Off. By default, peak hold
is on. The peak indicators, the white bars in record level controls, indicates the audio peak
you are currently recording.
4. To show the record level controls, choose Levels | Show Record Level Controls. To show
play level controls, choose Levels | Show Play Level Controls. To hide the level controls,
choose Levels | Hide Level Controls.
5. To work the record and play level controls independently, choose Levels | Independent
Controls. To gang the controls, choose Levels | Ganged Controls.
6. Click Close (
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Using clips
With VdrPanel, you can define, rename and delete a clip. You can load an existing clip or
group of clips.

Defining a new clip
There are two methods for defining clips:
• You can create and name an empty clip, then record to it (Name Clip First).
• You can start recording with an empty clip list, then rename the recorded clip to a
meaningful name (Record Clip First).
Either method creates and stores a named clip. Use whichever method is most convenient for
you. You can choose VideoClip | Rename Clip at any time to change a clip name.

Name clips first
To define a clip by first naming the clip:
1. Click in a panel to select it.
Select VideoClip | New Clip to open the New Clip dialog box.

2. Select a drive from the Drive list. The number of drives available depends on your
hardware.
3. Enter a clip name, up to 32 characters long. Spaces and uppercase characters are acceptable;
however, uppercase and lowercase characters will not distinguish clip names.
4. Click OK. The new clip is added to the clip list for the selected channel.
5. If the Loop button is pressed in the panel, a dialog appears asking you to specify the loop
duration in the form 00:00:00:00.
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6. Click the Record button (in the selected Panel dialog box) to begin recording. The timecode
and compression rate fields are updated.
NOTE: A video input signal must be present on the selected channel for
recording to start.
7. Click Stop to stop recording.

Record clips first
To define a clip by recording and then naming the clip:
1. Click a panel to select it.
2. If any clips are listed in the Clips box, choose VideoClip | Eject All Clips to clear the clip list.
3. Click the Record button in the selected Panel dialog box to begin recording. A clip named
#1 (or other number for a unique clip name) appears in the clip list for the panel.
4. If you are in Loop mode, the clip is limited in size to either 1,000 fields or to the last clip
length specified in the Loop Length dialog box.
5. Click Stop to stop recording.
If you repeat these steps to record additional clips, they are named sequentially—one
higher than the previous clip. For example, #2, #3, and so forth.
6. Choose VideoClip | Rename Clip to open the Rename Video Clip dialog box (see “Renaming
a clip” on page 34).
7. Click on the clip to be renamed (such as #1).
8. Enter the new name in the To field. Spaces and uppercase characters are acceptable;
however, uppercase and lowercase characters will not distiguish clip names.
9. Click OK.
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Loading and playing a clip
To load and play a clip:
1. Click in a panel to select it.
2. If the clip is already loaded, select it from the Clips box and go to step 7.
3. If the clip is not loaded, choose VideoClip | Load Clip to open the Load Clip dialog box.
4. If the clip you want to load is on a different drive, select a different disk drive in the Drive
box.
5. If the clip you want to load is not shown in the Clips list, click Show All Clips. This will
display all the clips in the bin, not only clips compatible with the current channel. Note that
clips not shown when Show All Clips is disabled probably can’t be played on this channel.
6. Select the clip to load—#1 in this example.
7. Click OK.
8. Click the Play button in the selected Panel dialog box to begin playing the clip.
9. The Normal or Loop modes determine how play back occurs:
- Normal mode plays the selected clip or clip list to the end, freezing on the last field of
the clip or of the last clip in the list.
- Loop plays the selected clip or clip list continuously, looping back to the beginning of
the clip when the clip ends, or in the case of a clip list, looping back to the first clip in
the list when the last clip ends.

23 July 2004

Profile XP User Guide

33

Chapter 2

Using VdrPanel

Renaming a clip
To rename a clip:
1. Choose VideoClip | Rename Clip. The Rename Video Clip dialog box appears.

2. If the clip you want to rename is in a different list, select it from the Drive box.
3. Select a clip from the Rename box. The clip name appears in the To box.
4. Edit the current name or delete the name and enter a new one. Clip names can have up to
32 characters. Spaces and uppercase characters are acceptable; however, uppercase and
lowercase characters will not distiguish clip names.
5. Click OK.
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Setting clip protection
To set clip read-only protection:
1. Choose VideoClip | Set Clip Protection and the Set Clip Protection dialog box appears.

2. If the clip you want to protect is in a different list, select it from the Drive box.
3. To protect a clip, select a clip in the Play/Record box and then click Protected. The clip is
now protected as read-only.
4. To unprotect or unlock a clip, select a clip in the Read Only box and then click Unprotected.
The clip is no longer protected.
5. Click OK.
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Striping a clip
Striping timecode with VdrPanel allows you to complete a striping process faster than real
time. For example, on a traditional VTR, it might take you an hour to stripe a one-hour clip.
But with VdrPanel, you can stripe a one-hour clip in a matter of minutes.
To stripe timecode on a previously recorded clip:
1. Choose VideoClip | Stripe Clip and the Stripe Timecode dialog box appears.

2. Enter the timecode you want to start the clip with, in the form 00:00:00:00.
3. Enter up to eight digits to mark the clip with user bits.
4. Click OK when complete.

Setting long or short clip names
Long clip names display the full path name of the clip, for example, INT1:\default\clipname.
Short clip names display only the clip name. Clip names are shown in Clip Name box in a
Panel.
To set the clip name to be short or long:
• Choose Options | Display Short Name or Options | Display Long Name.
NOTE: This setting only applies to the current panel. Each panel can have a
different setting for clip name length.

Ejecting all clips
To eject all clips:
1. Choose VideoClip | Eject All Clips.
2. All clips in the Clips box in the Panel are ejected immediately.
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Deleting a clip
To delete a clip:
1. Choose VideoClip | Delete Clip to open the Delete Clip dialog box.

2. If the clip you want to delete is on a different drive, select it in the Drive box.
3. Select the clip or clips you want to delete.
4. Click OK when complete. A message box appears telling you which file is being deleted.
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Clip lists
You can save and organize clips into lists (also called groups). You can load a saved group of
clips. You can also save an existing group of clips under a different name. You can also create
and later edit a list of clips. The groups that you save can be used in VdrPanel, but not in any
other Profile XP application.

Saving a group of clips in a clip list
A clip list can be saved and loaded later. To save a clip list as a group:
1. Click within the specific Panel dialog box to select the panel where the clip list is
currently displayed.
2. Choose File | Save Group of Clips and the current list of clips, as shown in the Clips box, is
saved in the current group (.grp). If the clips have not been saved in a group previously, the
Save Group of Clips dialog box appears.

3. If you have not already saved the group, choose File | Save Group of Clips As.
The Save As command enables you assign a different name to an already named group of
clips, preserving the contents of the original group. The saved group can be loaded at any
time with VideoClip | Load Group.
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Playing a clip list
To play a list of clips:
1. Click within the specific Panel dialog box to select the panel.
2. Choose VideoClip | Load Group if the clip list you want to play is not currently loaded.

3. Select the group and click OK. In this example, the group is Seismic.grp.
4. Click on the first clip in the clip list.
5. Click Play to start playing the clip list.
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Editing a clip list
To edit a clip list (group of clips):
1. Click a panel to select it.
2. Choose Video Clip | Load Group if the clip list to be edited was previously saved as a group.
Select the group and click OK.
3. Choose VideoClip | Edit Clip List to open the Edit Clip List dialog box.

4. To add a clip to the current list loaded in step 1, select a clip in the Clips box and then click
Add. It is added to the Clip List box (with a long clip name).
5. To remove a clip from the current list, select a clip from the Clip List box, and click
Remove to remove the clip from the list. This does not delete the clip from disk—it simply
removes a reference from the clip list.
6. To edit a different group, click Add Group to bring up the Load Group of Clips dialog box.
7. Click OK when complete.
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Setting in and out marks in clips
You can set a temporary beginning and ending to a clip by marking an in point, an out point
or both. The video and audio data is not lost, however: it simply is not used when the clip is
played. For example, if you set a mark-in point five seconds into a clip, it plays at the five
second mark instead of at the beginning, but if you remove a mark-in, it returns the beginning
of the clip to the actual clip start.
NOTE: Setting in and out marks applies to Panel Control only. It is not
recommended for other protocols.

Setting marks
To set a new in mark and out mark in a clip:
1. Click a panel to select it.
2. Create a clip, load a clip, or load a clip list and then select a clip from the list. The Clip
Position Bar is all the way to the left and the Timecode is 00:00:00:00.
3. Use the transport controls, drag the Clip Position Bar, or click on the Timecode display to
enter a timecode to locate the frame where you want to set the in mark.
4. Click Set In Mark. The Timecode display remains the same, but the Clip Position Bar jumps
to the far left, indicating the mark-in point on the clip.
5. Use the transport controls, drag the Clip Position Bar, or click on the Timecode display to
enter a timecode to locate the frame where you want to set the out mark.
6. Click Set Out Mark. The Timecode display remains the same, but the Clip Position Bar jumps
to the far right, indicating the mark-out point of the clip.
7. Drag the Clip Position Bar to the beginning of the clip.
8. Click Play. The clip starts at the in mark and stops at the out mark.

Removing marks
To remove in and out marks from a clip:
1. Select a clip containing marks in the Clip Name box.
2. Click the Remove In Mark button to remove a mark-in point and reset the clip beginning to
the actual start of the clip.
3. Click the Remove Out Mark button to remove the mark-out point and reset the clip ending
to the actual end of the clip.
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Trimming clips
You can trim a clip from the beginning of the clip to the in mark or from the out mark to the
end of the clip. This action affects all copies of the clip on all panels. The trimmed material is
not retrievable. A warning message and verification prompt are displayed before the function
completes.
To trim a clip:
1. Select a clip with either in or out marks or both in the Clip Name box.
2. Click the Trim to Mark button to remove the portion of the current clip preceding the in
mark.
3. Click the Trim from Out Mark button to remove the portion of the current clip following the
out mark.
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Using Media Manager
The Profile Media Manager allows you to have access to digitally stored media and provides
tools for managing that media—such as explore, cut, copy, paste, and delete. Media may be
stored locally your Profile XP system, or it may be on a remote Profile system. You can also
transfer media stored on any Profile system on your Profile network via a Fibre Channel
connection.
Digital video and audio media may be stored in volumes. A volume is a disk set or file system
on one of the following machines, including attached external media drives and centralized
file storage on an Open SAN:
• PVS1000, PVS1100, PVS2000, PVS3000, or PVS3500 Media Platform
• PDR200, PDR300, or PDR400 Video File Server
• PDR100 Professional Video Disk Recorder
If you move media between Profile systems, keep in mind the capabilities of your machines.
For example, you can transfer a DVCPRO 25 clip from a PDR400 to a PVS1000, but you
cannot play it on that machine. PVS1000 systems play and record MPEG clips only. A
PVS1100 system, on the other hand, could play the DVCPRO 25 clip.
With Media Manager, you view media in a tree structure. On disk, media may consist of video
and audio clips and masters. Clips and masters are organized into bins that are kept on a
volume or file system. A bin is a container for clips and masters, similar to a directory on a
computer. A clip refers to segments or portions of a media file or a media file in its entirety.
A master is an edited sequence of clips.
When a Profile system is part of an Open SAN, Media Manager displays the volume with the
media available in shared storage. Media manager displays the same volume for any remote
Profile systems that are part of the same Open SAN.
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Starting and exiting the Media Manager
To start the Media Manager application with Windows NT:
• Double-click the Media Manager shortcut icon.
Or:
• Choose Start | PDR Applications | Media Manager.
The Media Manger window appears. The tree pane is on the left and the contents pane is on
the right. What appears in the contents pane depends on what you select in the tree pane. For
example, if you select the volume icon INT: in the tree pane, the Recycled and default bins
appear in the contents pane. If you select a bin, the masters and clips in that bin appear in the
contents pane. Masters and clips will only appear in the contents pane.

To exit the Media Manager, choose File | Exit.
A message box is displayed, asking you to confirm that you really want to exit the Media
Manager application. Click the Yes button to confirm the exit or the No button to cancel the
quit command.
Whenever you start the Media Manager, a Hardware Communication Monitor is also started,
if it is not already running. This program makes calls to the disk recorder and keeps track of
the Profile host file (profile.hst) which lists Profile systems on the network. The Hardware
Communication Monitor is normally invisible in its operation, but is essential to the operation
of Media Manager. It appears in the Processes tab of the Windows NT Task Manager as
VMHWCOM.EXE; ending this process will stop Media Manager as well.
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Starting other applications from the Tools menu
You can start other tools and applications from Media Manager’s Tools menu:
• Choose Tools | Transfer Monitor to start the Transfer Monitor tool. See “Viewing the
Transfer Monitor” on page 68.
• Choose Tools | Media Manager to start another instance of the Media Manager.
• Choose Tools | Tool Box Editor to start the optional Tool Box Editor, if available. See the
Profile Tool Box User Manual.
• Choose Tools | List Manager to start the optional List Manager, if available. See the
Profile Tool Box User Manual.
• Choose Tools | Transcode to start the Transcode Utility. This utility converts media
between different compression formats, such as from DVCPRO to MPEG. You can also
use the Transcode Utility to create a new clip with the same compression format, but a
different compression setting. See “Using the Transcode Utility” on page 63.
When an application is started from the Media Manager, it initially connects to the machine
that was selected in the Media Manager’s machine list box. If the application is not installed,
an error occurs.

Viewing and hiding the Toolbar and Status Bar
By default, the toolbar is visible. To hide it:
• Choose View | Toolbar.
To make it visible again, choose View | Toolbar again.
By default, the status bar is visible. To hide it:
• Choose View | Status Bar.
To make it visible again, choose View | Status Bar again.
To refresh the tree and contents panes:
• Choose View | Refresh or press F5.

Viewing Help and software version information
To view Help topics on Media Manager:
• Choose Help | Media Manager Help Topics.
To view program, software version, and copyright information:
• Choose Help | About Media Manager.
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Connecting to a remote machine
You can connect from your local Profile XP machine to any remote Profile machine. You can
also connect remotely from any PC running Windows NT 4.0. A local Profile machine refers
to a Profile system on which you are currently using Media Manager. A remote Profile
machine refers to a Profile system that is connected to your local system via an Ethernet local
area network (LAN).
The Hardware Communication Monitor makes calls to the disk recorder, manages the
contents of the Profile host file (profile.hst), owns connections to the machines listed in the
host file, and passes on change notifications received from each of these machines when other
applications—such as other instances of Media Manager—are running simultaneously.
While Hardware Communication is initializing, Media Manager shows the Hardware
Communication Monitor message box. If you click the OK button, this message box is
minimized.
To connect to a remote Profile machine on your Profile network:
1. Choose Add/Remove Machine from the File menu or from the shortcut menu with a
right-click on a machine, volume, or network icon in the tree pane. You can also click the
Add/Remove Machine button on the toolbar. The Add/Remove Machine dialog box appears.
The label Local appears after the name of the local Profile machine.
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2. To add a remote Profile machine to the network host list, click Add. The Add Network Host
dialog box appears.

3. Enter the name of the machine in the New Host Name box. This can be the host name or
the machine’s IP address (such as 128.161.37.138).
4. Click OK. The new host name is added to the network host list. You can click the Add button
again to add as many machine names as you want.
5. Click OK. The connection status message box appears to show the progress of new
connections.
To remove a Profile machine from the network host list:
1. Choose Add/Remove Machine from the File menu or from the shortcut menu with a
right-click on a machine, volume, or network icon in the tree pane. You can also click the
Add/Remove Machine button on the toolbar. The Add/Remove Machine dialog box appears.
2. Select the name of the machine you want to remove in Network Host List box.
3. Click Remove.
4. Click OK.

23 July 2004

Profile XP User Guide

47

Chapter 3

Using Media Manager

Viewing the media hierarchy
The Media Manager window is divided into two main sections: the tree and contents panes.
Clips and masters appear in the contents pane. Items are listed alphabetically.
In the tree pane on the left, you can expand or collapse the tree hierarchy by clicking on the +
(plus) or – (minus) control buttons. If you click on a + button, the tree hierarchy is expanded
or opened so you can see the branch. For example, under a volume, you see bins. Clicking on
the – button collapses or closes the associated branch of the tree, hiding the bins under the
volume.

To explore the contents of an item, select the icon representing it and then choose Explore from
the shortcut menu which is displayed with a right-click. If present, clips and masters are
displayed in the contents pane. In this pane, you see information about the media:
• The name of the clip or master.
• The length of the media in the form 00:00:00:00 (Hours:Minutes:Seconds:Frames).
• The compression format of the media: MPEG, DVCPRO 25, or DVCPRO 50, for
example.
• The date and time the media was last modified, in the format: 12/2/94 9:40 PM (Month/
Day/Year Hours:Minutes AM/PM).
The icons shown in tree pane are explained in more detail here.
The Profile network icon is the root for all other items in the tree pane.
Profile machines. Each icon is labeled with the Profile machine’s name. A Profile
can be a local machine or one connected via Ethernet alone.
A Profile machine connected via Ethernet and Fibre Channel.
An unconnected machine icon. Appears if no connection could be made. This icon
cannot be expanded.

48

Profile XP User Guide

23 July 2004

Viewing the media hierarchy
A non-Profile server that recognizes Media Manager connection requests. Media
may be copied to this server from other machines on the Fibre Channel network.
A volume. A machine’s storage is divided into one or more volumes. The
volume icon represents a physical set of disks. A Profile XP has a single volume
comprised of all of its connected RAID disks, or when part of an Open SAN, the
volume comprised of all the RAID disks available as part of the shared storage.
Older Profile systems may have several —either an internal disk set, and
external expansion box (such as the PDX208), or a RAID disk array (PRS250).
A closed bin.
An open bin.
A Recycle bin appears below each volume.
A master.
A locked master.
Clips with audio and video.
Locked clips with audio and video.
Clips with no audio.
Locked clips with no audio.
Clips with audio only (no video).
Locked clips with audio only (no video).
An item in the Profile clip database that Media Manager does not recognize.
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Toolbar
The Media Manager toolbar provides one-button access to commands:
Add/Remove Machine:

Opens the Add/Remove Machine dialog box.

Select Current Machine
Up One Level:

box: Expands the machine item in the tree.

Goes to the folder one level up.

Cut: Removes the selected items and

copies them onto the clipboard. Use Paste to put

them in the new location.
Copy: Copies the selected items to the clipboard. Use Paste to put them in the new
location.
Paste:

Inserts the items you have copied or cut into the selected location.

Delete: Deletes
Properties:
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Displays the properties of the selected item.

23 July 2004

Copying media

Copying media
To copy one or more clips or masters:
1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the
contents pane.
2. Choose Copy from the Edit menu or from the shortcut menu with a right-click. You can also
click the Copy button on the toolbar.
3. Select the location where you want to paste the item. This can be another bin or anywhere
in the contents pane when a bin is selected. The selected location may even be in another
Media Manager window. If both the source and the destination locations reside on
machines connected to the Fibre Channel network, you may copy between machines.
4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can
also click the Paste button on the toolbar. A clip may be pasted into the same bin it was
copied from. In this case the clip is automatically renamed. Media Manager automatically
suggests a new name that does not conflict with any other item at the selected location. The
new name is based on the old name with the addition of a number: source becomes
source_1. When you are copying clips to a volume other than the source volume on a
Profile system, Paste Special is available as an option on the Edit and right-click shortcut
menus.
NOTE: It is possible to play clips or masters with VdrPanel or Tool Box Editor while
they are being copied over Fibre Channel.
To copy a bin:
1. In either the tree pane or the contents pane, select a bin.
2. Choose Copy from the Edit menu or from the shortcut menu with a right-click. You can also
click the Copy button on the toolbar.
3. Select another bin into which you want to paste the first bin’s contents. The selected
location may even be in another Media Manager window. If both the source and the
destination locations reside on machines connected to the Fibre Channel network, you may
copy between machines.
4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can
also click the Paste button on the toolbar. The bin may be pasted into the same bin it was
copied from. In this case the bin is automatically renamed. Media Manager automatically
suggests a new name that does not conflict with any other item at the selected location. The
new name is based on the old name with the addition of a number: source becomes
source_1.
NOTE: Copying a bin means that all clips and masters in the bin are copied to the new
location.
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Using Paste Special
Paste Special is a method of pasting clips or masters that are currently on the clipboard as a
result of a copy or cut operation. Paste Special is enabled only when you have selected a bin
on a different volume a bin on a remote machine.

Unlike Paste, which always copies the material between a clip’s mark in and out points, Paste
Special offers you the option of copying all the media that the clip references. To use Paste
Special after placing media on the clipboard, choose Paste Special from the Edit menu or the
right-click shortcut menu. When the Paste Special dialog box appears, click the button for the
paste option you prefer, then click OK.

Moving media
To move a clip or master to another bin:
1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the contents
pane.
2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. You can also
click the Cut button on the toolbar.
3. Select the location where you want to paste the media. This can be another bin or anywhere
in the contents pane when a bin is selected. The selected location may even be in another
Media Manager window. If both the source and the destination locations reside on
machines connected to the Fibre Channel network, you may copy between machines.
4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can
also click the Paste button on the toolbar. Pasting media into the same bin has no effect.
To move a clip or master using Paste Special:
1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the contents
pane.
2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. You can also
click the Cut button on the toolbar.
3. Select the location where you want to paste the media. To use Paste Special, you must select
a bin on a different volume, a bin on a remote machine.
4. Choose Paste Special from the Edit menu, or from the shortcut menu with a right-click.
When the Paste Special dialog box appears, click the button for the paste option you prefer,
then click OK.
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To move a clip or master using drag and drop:
1. In the contents window, select one or more clips or masters.
2. Drag the selection and drop it at the appropriate location. This can be a bin or anywhere in
the contents pane when a bin is selected. The selected location may even be in another
Media Manager window. The tree pane will automatically scroll when dragging a bin to the
very top or bottom of the tree.
If you hold down the Ctrl key when you drop the item, the item is copied to the new location,
not moved. Dragging a clip or a master to a different machine or volume always results in a
copy—the original clip is not deleted.
When copying or moving clips to a new location, if a clip or master with the same name
already appears at that location, you will be prompted to change the name or cancel the
operation, as shown here.

Duplicating media
To duplicate media means that you copy a clip or master and the underlying media files that
the clip or master reference. A normal copy operation between locations on the same Profile
machine does not copy the associated media files, only references to those media files.
NOTE: You can play clips or masters with VdrPanel or Tool Box Editor while Media
Manager is duplicating the clip or master. This is only practical for longer media.
To duplicate a clip or master:
1. In the contents pane, select the clip or master you want to duplicate.
2. Choose Duplicate from the Edit menu or from the shortcut menu with a right-click. The
Duplicate operation always automatically renames the new clip.
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Creating, renaming and deleting bins
A bin can have a name up to 32 characters long. Spaces are legal characters, but count for two
characters. Colons (:) and slashes (/) are illegal. Tildes (~) are illegal as a first character in a
bin name.
To create a new bin:
1. In the tree pane, select the machine or volume where you want to create the new bin. When
a volume icon is selected, the new bin is added to that volume. When a machine icon is
selected, a new bin is created in the first volume in that machine.
2. Choose New Bin from either the File menu or from the shortcut menu with a right-click.
3. A new bin called NewBin is placed in the tree. The bin name is highlighted so you can
change it. Accept the new bin name by pressing Enter.
NOTE: Renaming a bin involves modifying the path of every clip or master in the bin
to reflect the new name. If a clip or master cannot be renamed because it is locked or
in use, you end up with two bins: one with the old name and one with the new one. The
clip that could not be modified remains in the bin with the old name.
To rename a bin:
1. Select the bin in either the tree or contents pane.
2. Choose Rename from either the File menu or from the shortcut menu with a right-click. You
can also select the bin a second time.
3. The name of the bin is highlighted. Type a new name for the bin and press Enter.
NOTE: Deleting a bin involves deleting every clip or master currently in the bin. If a
clip or master cannot be deleted because it is locked or in use, the bin is not deleted
either—it will only contain those clips or masters that could not be deleted. The rest
go to the Recycle bin or are deleted directly.
To delete a bin:
1. Select the bin or bins in either the tree or contents pane.
2. Press Delete, Backspace, choose Edit | Delete or with a right-click, choose Delete from the
shortcut menu. Press Shift-Delete to skip the Recycle bin and delete the bin or bins
immediately.
3. The bin icon disappears from the tree and the contents of the bin are moved to the Recycle
bin.
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Renaming clips and masters
A clip or master can have a name up to 32 characters long. Spaces are legal characters, but
count for two characters. Colons (:) and slashes (/) are illegal in clip and master names. Tildes
(~) are only illegal as first characters.
To rename a clip or master:
1. Select the clip or master in the contents pane.
2. Choose Rename on the File menu or with a right-click. You can also select the item a second
time.
3. The name of the clip or master is highlighted. Type a new name for the clip or master and
press Enter.

Deleting clips and masters
When a clip or master is deleted, it is just moved to the Recycled bin. It is permanently deleted
when the Recycled bin is emptied.
To delete a clip or master:
1. Select the clip or master in the contents pane.
2. Press Delete, Backspace, or choose Delete on the File menu or from the shortcut menu with
the right-click. Press Shift-Delete to skip the Recycled bin and delete the material
immediately.
3. The clip or master icon disappears from the tree and is moved to the Recycled bin.

23 July 2004

Profile XP User Guide

55

Chapter 3

Using Media Manager

Always deleting clips and masters immediately
To always delete media immediately, avoiding the Recycled bin:
1. Select the bin labeled Recycled in the tree pane.
2. Choose Properties with the right-click or from the File menu. The Recycled Bin Properties
dialog box appears.
3. Click the Options check box to enable immediate removal of deleted items.
4. Click OK.

Emptying the Recycled bin
When a clip or master is deleted, it is moved to the Recycled bin and is permanently deleted
when the Recycled bin is emptied. If an item of the same name is in the Recycled bin, the new
item is automatically renamed.
To empty the Recycled bin:
1. Select the bin labeled Recycled in the tree pane.
2. Choose Empty Recycle Bin with a right-click or from the File menu.
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Viewing properties
Media Manager lets you view the properties of a volume, media properties for clips and
masters.
To view volume properties:
1. Select a volume in the tree pane.
2. Choose Properties from the File menu or from the shortcut menu with a right-click. You can
also click the Properties button on the toolbar. The Properties dialog box for volumes
appears.

23 July 2004

Profile XP User Guide

57

Chapter 3

Using Media Manager

To view media properties:
1. Select a clip or master in the contents bin.
2. Choose Properties from the File menu or from the shortcut menu with a right-click. You can
also click the Properties button on the toolbar. The Properties dialog box for clips or
masters appears.

3. Click the General tab to view these properties:
- A preview frame of the clip or master to help identify it. Preview frames are not
available for MPEG masters.
- The name of the clip or master.
- How many tracks the clip or master uses for both audio and video.
- The video format, either NTSC or PAL. NTSC clips are recorded with either
drop-frame or non-drop-frame timecode.
- The compression format, MPEG, DVCPRO 25, or DVCPRO 50, for example.
- The length of the clip or master. The length is shown in timecode format: 00:00:00:00
(Hours:Minutes:Seconds:Frames).
- The size of the media in megabytes (MBytes).
- The date and time that the media was created and the date and time it was last
changed. The date and time the media was created or last changed is shown in the
format: 12/2/94 9:40 PM (Month/Day/Year Hours:Minutes AM/PM).
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4. Click the Locked box to lock (or unlock) the media under Media Manager. Clips and
masters with the locked attribute cannot be renamed, deleted, or modified in any way.
If the Read Only Media box is checked, it means that the media is protected under
VdrPanel and cannot be deleted or rerecorded, but you can change marks. See “Setting
clip protection” on page 35.
5. Click the Transcode tab to view the transcode history for the master or clip. Each entry on
the history page contains the date and time of the conversion, user description, target
format, and when applicable, data rate, chrominance value, and GOP structure.
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6. Click the Aspect Ratio tab to view the aspect ratio that will be used when this clip is
up-converted to high definition as it is played on a high definition output.

Setting the clip aspect ratio
If you enable the optional Definition Independent (Agile Output) software on your system,
you can play standard definition MPEG 4:2:0 clips and high definition clips using an HD
decoder. You can use Configuration Manager to define a channel that uses either an SD or an
HD output for that decoder.
If you use an SD output, all HD clips are down-converted to SD, and their aspect ratio is
adjusted according to your settings in the channel definition. Similarly, if you use an HD
output, all SD clips are up-converted to HD, and their aspect ratio is also converted.
In some cases, you may wish to alter the aspect ratio of a specific clip in a way that is different
from that specified by the channel definition. For example, your channel may be set to play
4:3 material in pillarbox format on an HD output. But if a clip 4:3 SD clip contains 16:9
letterboxed material, you may find the up-converted material displays too much black. In this
case, you might want to set the clip’s aspect ratio conversion to Zoom, which would cause the
active video to fill the screen.
Changes to a clip’s aspect ratio conversion setting apply to specified clip only. If other copies
of the clip exist, you must change the settings for each of those clips individually.
To change the aspect ratio setting:
1. Select a clip or master in the contents bin.
2. Choose Properties from the File menu or from the shortcut menu with a right-click. You can
also click the Properties button on the toolbar. The Properties dialog box for clips or
masters appears.
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3. Click the Aspect Ratio tab to show the current settings for the clip. If you are viewing the
properties for a master, you will see the settings for all of its constituent clips.
4. Select the desired clip and choose Change to view the available settings. See the Profile XP
System Guide for descriptions of the conversion choices.
NOTE: You can only change the settings for SD MPEG 4:2:0 and HD clips. No other
clips can be played on an HD/SD channel.

5. Once you have selected the desired setting, click OK.
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Finding clips and masters
You can locate clips and masters anywhere on the Profile network. If you select the Profile
Network icon, you will search all machines on the network. If you select a machine, your
search will be limited to that machine’s volumes.
1. Select the item where you want to begin your search in either the tree or contents panes.
2. Choose Find on the Edit menu or from the shortcut menu with a right-click. The Find dialog
box appears.

3. Enter the name of the clip or master in the Named box—in this example, 10-28-97. The
Look In box indicates where the search will begin.
NOTE: Wildcards are not supported as search items. You must provide the exact name
of the item.
4. Click Find Now. Click Stop to end the search. When a match is found, the result is displayed
in the box at the bottom of the Find All Files dialog box, as shown.
5. If you double-click an item in the list of found items, the tree pane is expanded and the item
is selected in the contents pane.
6. You can copy an item from the found list by holding the Control key and dragging the item
to the desired location, or you can move it by dragging it without the Control key.
7. Click Close when you have completed your search.
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Using the Transcode Utility
NOTE: The Transcode Utility works only with standard definition video formats. You
cannot use it with high definition video.
If you have different types of codecs or encoders and decoders in your Profile system, you may
wish to convert clips from one compression format to another, such as from DVCPRO to
MPEG on a PVS1100. If your Profile system supports only one compression format, such as
MPEG on a PVS1000, you can use the Transcode Utility to create new clips with a different
video quality. If, as in the PVS1100 series, you can configure the codecs for different types of
compression, then you can convert clips as long you have configured a codec for each
compression type involved. The Transcode Utility is a tool that makes format conversions
easy. The Transcode Utility converts media files—clips and masters—in several different
ways. For example, depending on the Profile system’s capabilities, you may be able to
convert:
• From MPEG to MPEG using a different video quality
• From MPEG to DVCPRO
• From DVCPRO 25 to DVCPRO 50
NOTE: Converting a low-quality video clip to a higher bit rate will not improve the
video quality of the clip.
The Transcode Utility is started from the Tools menu in Media Manager.
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To convert clips or masters:
1. Select one or more clips or masters that you want to transcode in Media Manager’s contents
pane.
2. In Media Manager, choose Tools | Transcode. The Transcode Utility dialog box appears
with the selected media in the transcode list.
3. You may add more clips or masters to the transcode list by dragging them from Media
Manager and dropping them on the list. You can also transfer media using Copy and Paste
commands.
4. In the Convert tab, select the target format from the drop-down list. Some choices might be
MPEG, DVCAM, DVCPRO 25, or DVCPRO 50, depending on your system’s capabilities.

5. In the Video Quality box, select a video quality if you want something other than the default
(Medium). The higher the quality, the more disk space is used.
6. To change a custom quality setting, click the button next to the Video Quality list box, and
the Custom Video Quality Settings dialog box appears. Select either Custom1 or Custom2
in the Video Quality list box. When selected, you can change the name of a custom setting.
Click Undo to cancel changes and OK when done.
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For MPEG, select a chrominance value, either 4:2:0 or 4:2:2. Then move the diamond on
the grid or click the High, Medium, Low, or Draft button—the corresponding bit rate and
picture structure is shown on the right side of the dialog box.
NOTE: To make an MPEG clip I-frame, drag the diamond to the far left side of the
grid.

Table 2. MPEG Video quality (compression)
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Quality Settings

Compression in
Mbps

Chrominance

Draft

4

4:2:0

Low

8

4:2:0

Medium (default)

15

4:2:2

High

24

4:2:2

Custom 1 or 2

4–50

4:2:2 or 4:2:0
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7. In the Preview tab, select a video output for the source clip or master from the Source Video
Output box. This allows you to watch the source media play out on the monitor during the
conversion.

8. From the Target Video Output box, select a video output for the target clip or master.
This allows you to compare video quality by watching the target media play out on a
monitor during the conversion, with a few seconds delay from the source media.
9. If there is media in the list that you have decided not to convert, select it in the media
pane, then click Remove.
10. If you want to delete the original clip or master automatically after it is converted, click
Delete source after conversion. This will save disk space.
NOTE: A deleted clip or master cannot be restored.
11. Click Start. The Transcode Description dialog box appears. Enter a descriptive message
to be stored as part of the transcode history and when done, click OK to continue the
conversion.
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The conversion starts with the first clip or master in the list and continues to the last. If
the media are not deleted (see step 10) the source clips and masters are moved to a
backup bin. For example, if the source media is in the default bin, the original source is
moved to a bin called default_bak (bin basename plus _bak). You can stop the conversion
process at any time by clicking Stop. Start the process again by clicking Restart.
NOTE: An error occurs (listed in the Status column) when a clip is the wrong video
standard, is already present in the _bak bin, or cannot be opened, among other faults.
12. Click Close or choose File | Exit.
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Viewing the Transfer Monitor
When clips are copied to a different machine, the media that is referenced by those clips is also
copied. This is made possible by using a combination of Ethernet and Fibre Channel networks,
or Ethernet and Ehternet Video Network. Ethernet is used for lower-speed database transfers
and queries. The high speed Fibre Channel network or lower speed Ethernet Video Network
is used for transferring the actual media between machines.
Copying media is done in the background to allow you to continue with your work. Since this
may result in more than one transfer occurring at the same time, the Transfer Monitor is used
to keep track of these background tasks. Each time a media transfer is started, a new entry
appears in the Transfer Monitor.
The Transfer Monitor can be opened at any time. It consists of two tabs: the Network tab
which shows all copies over Fibre Channel and Duplicates in progress; and the Library tab
which shows any ongoing library transactions on PDR systems.
To track background operations with the Transfer Monitor:
• Choose Tools | Transfer Monitor or click the Profile logo on the toolbar. The Transfer
Monitor dialog box appears.

The Profile logo on the Media Manager toolbar is animated whenever there is an archive item
in the Transfer Monitor, whether the Transfer Monitor is open or not. If there are only error
items in the Transfer Monitor the error logo appears, without animation.
The Network tab divides entries into four columns: source, destination, percent complete, and
average megabytes per second. When copying, source and destination paths are constructed
using the machine/volume/bin/clip names. A destination clip name may be different from the
source clip name if the clip was renamed when pasted or moved to the new location (which
has to be done when a clip with the same name already appears at the new location).
To interrupt a transfer do the following:
1. Click the Network or Library tab depending on the type of transfer you wish to interrupt.
2. Select the transaction you wish to interrupt.

68

Profile XP User Guide

23 July 2004

Viewing the Transfer Monitor
3. Click the Cancel Transaction button. (This button is unavailable unless the transaction is
highlighted.)
The label for this button is context specific. If an archive transaction was selected, the button
is labeled Cancel Archive. If a network copy was selected, the button is labeled Cancel
Transfer.
Occasionally an error will occur while a transfer is in progress. The destination machine may
have unexpectedly run out of storage, the network connection may have gone down, there may
have been trouble reading an archive library cartridge. An error is indicated by a change in the
Profile logo.
In the Transfer Monitor, entries that could not complete due to error are displayed in red and
their percent complete shows Error. When the entry is selected, a short description of the error
is shown at the bottom of the window. To remove the entry, select it and then click the Remove
button.
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Glossary
Access Time
The time it takes to find and retrieve digital information, generally from hard disk
storage.
AES/EBU
Acronym for Audio Engineering Society/European Broadcasting Union, an industry
standard for the transmission of serial digital audio information. The standard
specifies the physical attributes of the link, as well as how the information is
transmitted along it.
A to D
Analog-to-digital converter. An electronic component that converts incoming analog
signals into its digital representation.
Analog video
Video represented as a continuously variable electrical signal. Consumer TV and
domestic VCRs are analog video devices. Analog video can be converted to digital
format to be stored and manipulated by computer or other digital devices.
Audio board
The audio board on the Profile XP that provides 16 channels of analog, embedded
digital, and AES/EBU digital audio. You can install up to two audio boards in a
Profile XP for 32 channels of audio.
Assemble record mode
Video and all audio tracks assigned to a machine are recorded simultaneously, along
with timecode, and any previous contents are overwritten. Traditionally this mode is
used when appending to a master tape that has not had black, timecode, and control
track previously recorded before editing.
Audio I/O
The audio path through the Profile XP Media Platform video disk recorder, especially
the crosspoint circuitry that routes the audio within the Profile system.
Auto Start
A feature that lets you enter a timecode and have the record buffer start recording at
that timecode.
Bit rate
The rate at which video streams in megabits per second (Mb/sec). The bit rate is a
reflection of quality—the higher the bit rate, the higher the quality of video. However,
video data stored at a high bit rate consumes more disk storage space than data stored
at a lower rate. Bit rates can be as low as 6 Mb/sec and as high as 54 Mb/sec. The
default video quality bit rate is 24 Mb/sec, which is broadcast quality.
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BNC
Connector used in professional A/V components. The BNC connection provides
optimum shielding between the video input signal lines to provide the best possible
performance. BNC was recently adopted as an alternate AES signal connector.
B Picture
A B picture is a bidirectionally-predictive picture used in MPEG video compression.
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not
duplicating pixels that do not change from frame to frame. A B picture relies on data
from both forward and backward motion vectors to determine how a future frame will
be composed. See GOP, I-frame, P Picture.
Button (on the display)
A small display box that has a raised appearance and contains text. Generally, clicking
on a button activates a function or performs some action. See Clicking.
Button (on the mouse)
The two or three buttons on the top of the mouse.
Capture
Generally, the act of storing digital audio and video in memory or on a disk. The
process may involve converting an analog signal to a digital one. Some compression
of the digital data may be involved.
CD-ROM
Compact Disc-Read-Only Memory, the preferred medium for multimedia storage
because of its large capacity, high quality, ease of use, and low cost.
Channel
A collection of video, audio, and timecode resources used for either playing or
recording.
Chroma
A term that describes the saturation or vividness of a color. A chroma of 0 describes
a neutral, gray color. Chroma ranges to the most vivid color a screen or printer
generates for a specific hue and value. See Hue.
Clicking
Quickly pressing and releasing the left mouse button (usually) without moving the
pointer.
Clip
A clip is a reference to recorded video or audio tracks from a single source, and may
include timecode. If a clip includes both video and audio, they must be synchronous.
A reference to several clips edited together is called a master. Deleting a clip will
delete its associated material only if that material is not used by another clip or master.
Clip position
Clip position refers to the current location in a clip, denoted by timecode.
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CODEC
CODEC is an acronym for Coder/Decoder, a device which encodes and decodes a
specific data type. For example, an MPEG codec compresses CCIR 601 digital
component video for storage on disk, but can also decompress the stored data and
return it to its original CCIR 601 digital component format.
Command line
The line that you type to invoke a program or initiate an action. A command line
usually contains the application program name, along with optional arguments known
as command-line options.
Composite video
A single video signal composed of combined luminance and chrominance
information.
Component video
Typically the transmission or storage of video as a separate luminance and
chrominance information, such as Y, B–Y, R–Y, or Y, Cr, Cb.
Compression, video
A technique for reducing the amount of space needed to store images or sequences of
images. DVCPRO 25, DVCPRO 50, and MPEG are examples of video compression
techniques.
dB
Decibel. In theory, the minimum change in sound intensity that the human ear can
distinguish; also, a relative unit used to compare the strength of acoustic signals.
Default
A value that is automatically assigned or used in the absence of any other input. For
example, a new Profile system shipped from the factory is zero-timed by default while
E to E mode is the nondefault setting.
Dialog box
A box displayed in a computer application’s graphical user interface where you
choose options and enter information. Use the mouse or keyboard to move from field
to field, click on buttons and position the text insertion point. Enter information with
the keyboard.
Digital
In digital audio/video systems, sounds and images are converted into a series of binary
values (ones and zeros).
D to A
Digital-to-analog converter. A device used to convert digital signals into an analog
form. For example, compact disc players use D to A convertors to convert the digital
information on the CD into analog audio suitable for amplification.
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Disk expansion unit
A product (PDX208 and PDX218) that adds disk storage to a Profile video disk
recorder (PDR).
Disk Utility
The Profile Disk Utility tool is used to maintain Profile hard drives. This includes
formatting and labeling disk volumes, eliminating bad blocks, and updating hard
drives with new microcode.
Display
A device that receives video output from a display adapter such as VGA card and
displays the video output on a screen.
Dragging
Pressing and holding down the left mouse button while moving the pointer. The
mouse pointer must be over an object such as a file.
Drop-frame
In NTSC, you don't actually get 30 frames per second; the real number is about 29.97
fps. Timecode usually assumes 30 fps. To account for the discrepancy, drop-frame
timecode skips or drops two timecode values at the beginning of every minute except
every tenth minute. This allows timecode to exactly match a real-time clock on 525/
60 systems. This correction is not needed on 625/50 systems because the frame rate
is exactly 50 fps.
DVCPRO
A non-proprietary digital video compression format standardized as SMPTE D-7.
DVCPRO 25 uses a fixed data rate of 25 Mbs, while the DVCPRO 50 data rate is
fixed at 50 Mbs.
E to E (EE)
Electronics to Electronics mode routes audio and video input directly to output.
Edit
The process of creating or refining a sequence of media (clips) in a specific order.
EDL
An Edit Decision List is a list of events that include the source to be recorded, and
where to record it. In addition, an EDL can include information about transitions
(cuts, dissolves, wipes), transition durations, effects, etc.
Factory default
The value assigned to a parameter as delivered from the factory. See Default.
Field
A part of the total number of lines that represent a video image, scanned in two passes.
For example, an NTSC 525-line frame is divided into 262.5-line fields. See Frame.
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Firmware
Software instructions that are permanently stored in the memory of a computer and
are not lost when you turn the power off.
fps
The abbreviation for frames per second, the standard way of measuring the speed of
video playback. Thirty fps is considered real-time playback in NTSC, 25 fps in PAL.
24 fps is standard for film and is considered animation speed playback. In the range
of 12 to 15 fps, the human eye can detect the difference between one frame and the
next; visually this appears as a jerky motion, or flicker.
Frame
The standard unit of measure for film and video. One frame represents one complete
still image, divided into two fields.
Frequency response
The frequency range which an electronic component can accurately reproduce.
Humans (some) can hear from 20 Hz to 20,000 Hz (20 KHz). An ideal audio
component would have a frequency response, totally flat and without any deviation,
from 20 Hz to 20 KHz. Frequency response specifications are measured in decibels
(dB), based on how closely an output's response resembles that of the input.
Genlock
This term defines the relationship between video paths. Two video signals that are
exactly synchronized are said to be genlocked.
GUI
A Graphical User Interface (GUI) provides a visual way to interact with computer
software. GUIs allow people to control an application by using a pointing device such
as a mouse to perform operations. The usual alternative to a GUI is a command-line
interface, which requires people to type in application-specific commands following
precise rules of syntax. GUIs are considered easier to use than command-line
interfaces.
Group
In audio terms, this provides the ability to group tracks to perform functions across
several tracks at the same time, such as gain, mute, etc.
GOP
A Group of Pictures (GOP) is part of the video compression scheme used by MPEG.
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not
duplicating pixels that do not change from frame to frame. It does so by relying on a
GOP. A GOP is composed of I-frames, B pictures, and P pictures. See B Picture,
I-frame, P Picture.
Hard disk
Computer systems use hard disks as permanent storage devices. Information is
magnetically recorded on spinning platters for quick access.

23 July 2004

Profile XP User Guide

75

Hardware
The physical parts of a system, such as a computer, display monitor, or keyboard.
Help
Profile software applications come with on-line help manuals that include examples,
demonstrations, and reference information about using the application. The manual,
and the Help window it is displayed in, follow the Microsoft standard.
Hertz (Hz)
Hertz is the unit of frequency named after the physicist Heinrich Hertz (1857–1894).
One hertz (Hz) is equal to 1 cycle/second.
Hue
A term that describes a color family (for example, red or yellow). Hue is a polar
coordinate—that is, it moves in a circular motion around the color spectrum—and
ranges from 0 to 360, with 0 being red. Hue is measured in degrees. See Chroma.
I-frame
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not
duplicating pixels that do not change from frame to frame. It does so by relying on a
GOP. A GOP is composed of I-frames, B pictures, and P pictures. An I-frame (or
Intra-coded picture) is analogous to a JPEG frame in that it is a self-contained picture.
It does not use motion vectors as do the B picture and P picture. See B Picture, P
Picture.
Input device
A device that allows you to send information to a software application. Typical input
devices include keyboards, mice, tablets, and trackballs. See Pointer and Pointing
Device.
Insert record mode
In insert record mode, audio and video material can be recorded independently. New
material can replace existing material anywhere in the program. Insert record mode
requires timecode on the destination.
Interface
A common connection that is used for sending or accepting information and control
between programs and machines.
Keyboard
An alphanumeric input device that allows communication with software applications.
LTC
Longitudinal Time Code is typically an analog audio track or a dedicated address
channel on a tape. LTC can't be read in still mode, and may not be reliable during
low-speed shuttle operations.
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Media files
Audio, video, and timecode sources that have been captured by the Profile disk
recorder are considered media. Media is stored on disk as media files. Audio and
video clips do not contain media, but instead reference positions in a media file.
Memory
A component of a computer system used for virtually instantaneous temporary
storage and retrieval of information (data) or instructions (programs). Information in
memory is volatile, and is lost when the computer is shut down. Storing information
on a permanent storage device such as a hard disk or a tape allows for retrieval during
another work session.
Menu
A list of commands or functions that you select with a pointer. A menu is normally
displayed in a small window.
Monitor
Two-channel audio output of selected machine tracks. Generally, audio systems or
video displays used in a studio environment to control quality. Also, a video display
device, without audio capabilities.
Mouse
An input device that, when moved across a flat surface, causes the pointer to move
across a screen. The mouse usually has buttons that you press to send signals. These
signals, in turn, accomplish certain functions. The representation of the mouse on the
screen is called the pointer. See Pointer.
MPEG
MPEG (Moving Picture Experts Group) is a set of standards used for compressing
digital video and audio. MPEG uses compression methods that maintain high quality
while requiring smaller bandwidths to transport video and audio streams. MPEG D10
is a special form of MPEG compression for use with tape, that has a fixed data rate of
50 Mbs and a constrained byte GOP structure.
NTSC
The standard composite color format used in North America and Japan that was
developed by the National Television Standards Committee.
Open SAN
Grass Valley’s shared storage solution that provides centralized RAID storage for
multiple Profile XP Media Platforms.
PAL
The Phase Alternate Line standard is used to encode color information in Western
European composite video.
Panel
The graphical representation of a channel. in Profile applications such as VdrPanel
and TimeDelay. A record panel shows controls for the record channel. A player panel
shows controls for a play channel.
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Parameter
A variable that is given a specific value. This value is passed to a program before
execution.
Pixel
The smallest part of a display memory that can be addressed.
Playback
Playback is the act of playing a clip, track or master loaded on a machine at any rate.
Playback delay
The amount of time that the playback channel is behind the record channel.
Pointer
The pointer allows you to make selections in menus, to size and position windows and
icons, and to select the window where you want to send the input. The window
manager, such as Windows NT, determines the shape of the pointer. See Pointing
Device.
Pointing device
Typically a mouse, tablet, or some other device with effective dimensional motion.
See Pointer.
Port
A physical connection (such as a multi-pin connector or coaxial connector) and its
associated firmware, that permits one computing device to communicate data and
control information with another computing or peripheral device.
P Picture
A P picture is a predictive-coded picture used in MPEG video compression. MPEG
uses motion prediction to increase efficiency, that is, it reduces data by not duplicating
pixels that do not change from frame to frame. A P picture relies on data from
forward-moving motion vectors to determine how a future frame will be composed.
See B Picture, GOP, I-frame.
Protocol
A set of rules that allows computers to transfer information across a network to other
computers.
Read-only memory (ROM)
Memory that is not erased when power is turned off. It is also called firmware. The
firmware in a computing device allows it to boot without being connected to a host
computer.
Real-time
Generally considered to be 30 fps in NTSC, 25 fps in PAL, 24 fps for film. In
computer terms, processing information as it becomes available, rather than storing
for processing at a later time.
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Record Buffer
Determines the length of the Time Delay clip that the record buffer loop records on.
Resource
A resource is a Profile input, MPEG encoder, or output. You allocate resources for
exclusive use by any application, such as Tool Box Editor, List Manager, and
VDRPanel. You should free up (deallocate) unneeded Profile resources whenever
possible to that they can be used by other applications.
RGB
An additive method of combining percentages of red, green, and blue primary colors
to form other colors.
ROM
See Read-Only Memory.
RS-232-C
A standard serial communications interface for data communications, commonly
used for communications between a computer and modem, or to control automated
devices which don’t have a conventional computer operating system.
RS-422
A standard serial communications interface for data communications, similar to
RS-232-C, but good for longer distance cabling. It is typically used for
communications in a broadcast or post-production environment between devices such
as VTRs, mixers, and controllers.
SCSI Channel (Small Computer System Interface)
The interface between the Profile PDR processor and the disk array. It is fast and wide
and provides for speeds up to 20 Mbytes/second on a 16-bit bus.
SDI
An acronym for Serial Digital Interface, a standard for transmitting CCIR 601 digital
video over a pair of conductors (coaxial cable).
SECAM
France and Russia use the Séquence Couleur À Mémoire standard color format.
Serial port
Usually, the standard RS-232-C of a personal computer. Attach a serial cable to
communicate with a peripheral device such as a modem or printer.
S/N Ratio
The Signal-to-Noise Ratio, measured in decibels, is the ratio between the maximum
signal level and the noise level with no signal present. The higher the value, the better
the sound reproduction.
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Source
In Profile operations, a source is any signal (video, audio, or timecode) presented to
the machine inputs. A VTR output, a satellite downlink, a camera output, and a
facility router output are all examples of sources.
Status bar
The status bar at the bottom of most windows provides status information, short
explanations of commands and errors.
Text insertion point
The I-shaped pointer which appears in a text input area. Clicking the mouse in a text
input area causes the text cursor to appear in that area. Whatever information you type
on the keyboard appears in the text input area displaying the text cursor.
Timecode Source
LTC, VITC, Timecode generator
TimeDelay
The name of the application and the amount of time that elapses between the start of
the record channel and the start of the playback channel.
Tool Tips
A tool tip is a small pop-up window that displays a single line of text describing the
purpose of a control in a window. A tool tip is hidden most of the time, appearing only
when the user puts the cursor on a tool and leaves it there for approximately one-half
second. The tool tip appears near the cursor and disappears when the user clicks a
mouse button or moves the pointer off of the tool.
Tracks
Clips and masters are made up of individual tracks. A clip may consist of any
combination of a video track, timecode track, and up to 16 audio tracks. A master may
consist of any combination of a timecode track, 0-4 video tracks, and 0-16 audio
tracks.
Trimming
Shortening an originally recorded media file to a desired duration using the In and Out
marks. Material beyond the In and Out points is removed from the volume unless it is
used in another clip or master.
Video interface
The link to or from the internal video router and the external video signal. An example
is a composite analog input channel. This path takes a composite analog video signal
and converts it to 8-bit component parallel digital and places it on the video router.
Another example is the component serial digital output. This path takes component
parallel digital video from the video router and converts to serial digital component
format.
Video disk recorder/ server
A device such as the PVS1000 Media Platform that stores audio and video as digital
information on disks.
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VITC
Vertical Interval Time Code is encoded into the video lines at the start of field. VITC
can be read during still frames, but becomes unreliable at frame rates faster than
normal play speed, such as fast shuttle operations.
Video router
The video path through a system. The crosspoint circuitry that routes the video within
the Profile video disk recorder is a router.
Volume
A volume is a logical set of disks, such as the RAID disks connected to a PVS1000,
which are used as a grouping of disks for the storage of audio and video information.
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protect 35
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Clip position 72
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Closing an application 13
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Command Line 73
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Ctrl key 8

D
D to A 73
dB 73
Default 73
Defining clips 31
Deleting clips 36
Deleting media in Media Manager 55
Desktop, Windows NT 12
Dialog box 73
Disk Expansion Unit 74
Disk Utility 74
Display 74
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Editor, Tool Box 17
EDL 74
Ejecting clips 32, 36
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56
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Explore in Media Manager 48
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Finding Clips and Masters 62
Finding media in Media Manager 62
Firmware 75
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fps 75
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Free Run timecode 22
Freeze timecode 22
Frequency response 75

G
Generator, timecode 22
Genlock 75
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GOP 75
Graphical user interface 75
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GUI 75

H
Hard disk 75
Hardware Communication Monitor 44
Help 76
Help files 13
Hertz (Hz) 76
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Icon definitions 48
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I-frame 76
In marks 25, 41
Input device 76
Insert record mode 76

K
Keyboard 76
Keys, shortcut 27

L
List Manager 15, 17
Loading clips 33
Lock to Field Number 22
Locking clips 35
Logging in 11
Long clip names 36
Loop 24
LTC 22, 76

M
Manual conventions 8
Manually logging in 11
Marks 20, 25, 26, 41
Master
delete 55
renaming 55
Media files 77
Media Manager 14, 43-69
copying and pasting media 51
creating, renaming, deleting bins 54
deleting clips and masters 55
duplicating media 53
emptying recycle bin 56
icons 48
moving media 51
renaming clips and masters 55
starting and exiting 44
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Tools menu 45
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viewing the hierarchy 48
Media properties 57
Memory 77
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Monitor 77
Mouse 77
Moving media in Media Manager 51
MPEG 63, 77

N
Network host list
add or remove machine 47
New clips 31
Normal 24
NTSC 77

O
Odetics 10
Open SAN 11, 43
Out marks 26, 41

P
P picture 78
PAL 58, 77
Panel
Back One Field 26
basics 24
Clip Name Box 27
Clip Position Bar 25
Fast Forward 25
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Go to Clip End 26
Group Name Box 26
Loop 24
making active 28
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PB/EE 25
Play 25
Playback 25
Record 25
Remove In Mark 25
Remove Out Mark 26
Rewind 25
Set In Mark 25
Set Out Mark 26
Shuttle Bar 26
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Shuttle Rate 26, 27
Stop 25
tiling 28
Timecode 25
Trim from Out Mark 26
Trim to In Mark 26
Parameter 78
Paste Special 52
PB/EE 25
Peak hold 30
Pixel 78
Play 25
Playback 25, 78
Playback delay 78
Playing clips 33
Pointer 78
Pointing device 78
Port 78
Powering on 11
Profile Protocol 10
properties, media 57
Protecting clips 35
Protocol 78

R
Read-only memory 78
Real-time 78
Record 25, 32
Record Buffer 79
Record Capacity 29
Regenerate timecode 23
Remote Profile machine 46
Remove In Mark 25
Remove Out Mark 26
Removing a Profile machine 46
Renaming clips 34
Renaming media in Media Manager 55
Resources 79
Rewind 25
RGB 79
Right-click 8
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S
S/N Ratio 79
Save Group of Clips 38
SCSI 79
SDI 79
SECAM 79
Select timecode 22
Serial port 79
Set In Mark 25
Set Out Mark 26
Short clip names 36
Shortcut keys, VdrPanel 27
Shuttle Bar 26
Shuttle Rate 26, 27
Size box 24
Software Development Kit 10
Source 80
Starting an application 13
Status bar 80
Status Bar, Media Manager 45
Stop 25
Striping a clip 36

T
TC Recorder 22
TekCfg 10
TekPdr 10
TekRem 10
TekVdr 10
TekVfs 10
TekXfr 10
Text insertion point 80
Timecode 22, 25
display 25
drop-frame 23
free run 22
freeze 22
lock to field number 22
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Timecode Source 80
TimeDelay 15
Tool Box Editor 15, 17
Tool Tips 80
Toolbar
Media Manager 45
Toolbar buttons 50
Tracks 80
Transcode Utility 63
Transfer Monitor 68
Tree hierarchy 48
Trim from Out Mark 26
Trim to In Mark 26
Trimming 80
Type box 24

U
Unlocking clips 35

V
VDCP 10
VDCP modes 21
VDCP stop mode 21
VDCP switcher mode 21
VdrPanel 14, 17
shortcut keys 27
Video disk recorder/server 80
Video interface 80
Video router 81
VITC 22, 81
Volume 43, 49, 81
VTR 9

W
Windows NT 4.0 13
Windows NT desktop 12
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